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Course Overview 

Welcome to Production / Post 
Production 

In this block, you are going to study about the basic techniques of 

2D animation practical. Before setting your hands into the 

practical, you have to learn about the theoretical aspects of 

2Danimation. There are some common ingredients of a successful 

2D design. Painting, animating, making background, lighting, 

character animating, portfolio making are discussed in this block. 

 

Painting & Animation 

Paint is an introductory exploration of computer graphics as a 

technology and a creative medium. Through the use of the 

industry-standard software, Adobe Photoshop, students learn the 

fundamentals of working with raster editing software for digital 

graphics creation and image manipulation.   

Understanding Background 

Composition  

Design for animation pertains to many areas of 2D, from the 

location design, to the props and to the look of the characters. It 

involves understanding the principles and elements of design and 

how it applies to the often stylized and caricatured look of 2D 

animation. 
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2D Animation Technique  

Traditional character animation through the introduction of a 2D 

digital software package. Students will understand the basics of 

how to draw, animate, import sound, composite and export in this 

digital software.   

2D Animation for portfolio Making  

Portfolios are also one of the most important tools for initially 

getting a job or contract. This module provides the knowledge and 

tools required to prepare a high-quality academic and professional 

portfolio.    

This video will provide a brief overview of this course. 

 

Topic YouTube link QR 

Code 

Video 1 –project preparation 

for Broadcasting  
https://youtu.be/J0YVuo5

VsYA 

 

Video 2 –2DGlobe animation 
https://youtu.be/V03iKGX

QjnE 

 

Video 2 –Show reel 

preparation 
https://youtu.be/BlFMd2sc

rz0  

 

 

 

 

 

https://youtu.be/J0YVuo5VsYA
https://youtu.be/J0YVuo5VsYA
https://youtu.be/V03iKGXQjnE
https://youtu.be/V03iKGXQjnE
https://youtu.be/BlFMd2scrz0
https://youtu.be/BlFMd2scrz0


   
 2D Animation 

 
7 

 
 

 

Course outcomes 

Upon completion of preproduction you will be able to: 

 

Outcomes 

 Understand the stages of 2D animation 

 List the techniques of scanning inked drawings 

 Understand the basics of background composition in 

animation  

 Plan the background  

 Apply the 2D animationtechniques 

 List the various techniques of 2D animation  

 Understand portfolio 

 Know the steps and rules to make a portfolio 

 

Timeframe 

 

How long? 

This course will be completed within “4” classes. 

This course is of “1” credit. 

8 hours of study time is required for this unit. 

 

 

Study skills 

 

This is a combination of theory and practical. 

Hence, you should have access to a personal computer or personal 
laptop for better understanding of this unit. 

Each and every option is explained step by step in the course 
material.  

Apart from this course material, the learner needs to adopt the 
tendency of learning from multiple sources i.e.; 

Internet tutorials 

Video tutorials on YouTube 
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Collaboration with people working in the industry etc. 

Only classroom study will not make you a professional. You have 
to be active to grab the opportunity of learning wherever you get 
a chance. 

 

Need help? 

 

Help 

In case you need any help, you can browse the internet sites such as 
youtube.com for video tutorials about the subject. 

 

 

 

Assignments 

 

Assignments 

There will be some assignments at the end of each unit. 

These assignments are mostly practical based and should be submitted 
in CDs or DVDs. Theoretical assignments are to be submitted written on 
A4-size sheets. 

All assignments will be submitted to respective study centres of the 
Odisha State Open University or as directed by the co-ordinator. 

All assignments should be unit wise on separate CD/DVDs clearly 
mentioning course title and unit on the top. Theoretical assignment will 
be neatly filed or spiral bind with cover mentioning necessary 
information of course, student detain on top. 
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Assessments 

 

Assessments 

There will be “1” assessment for each unit. 

All practical assessments will be submitted to the OSOU. 

Assessment will take place once at the end of each unit. 

Learner will be allowed to complete the assessment within stipulated 
time frame given by the university. 

 

 

Video Resources 

This study material comes with additional online resources in the form of 

videos.  As videos puts in human element to e-learning at the same time 

demonstrating the concepts visually also improves the overall learning 

experience. 

You can download any QR code reader from Google Play to view the 

videos embedded in the course or type the URL on a web browser.  

 

 

Reading 
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Getting around this course material 

Margin icons 

While working through this course material, you will notice the frequent 
use of margin icons. These icons serve to “signpost” a particular piece of 
text, a new task or change in activity; they have been included to help 
you find your way around this course material. 

A complete icon set is shown below. We suggest that you familiarize 
yourself with the icons and their meaning before starting your study. 

 

 
 

 

 

Activity Assessment Assignment Case study 

    

Discussion Group activity Help Note it! 

   

 

Outcomes Reading Reflection Study skills 

 
   

Summary Terminology Time Tip 
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Unit-1 

Painting & Animating Practical 

Introduction 

Before beginning 2D animation, you require pictures or artistic 

creations. Your drawn edges should be converted into an 

advanced digital format. Keeping the end goal in mind, you need 

to check the drawn frames. So before you check them, you will 

need to set them up for the scanner. Consider the line quality that 

is on the paper. If it's too light, the scanner won't lift it up, and you 

will need to settle those lines in the PC or totally redraw them 

later. 

In this practical unit, you will learn the basics of animation 

techniques, implementation of traditional 2D techniques in digital 

animation, understanding the techniques of scanning the 

drawings. You will be introduced to ink paint of drawings, the 

techniques of tracking and tracing the paths, various paint 

techniques involved in animation production and painting them in 

2D painting tools. Thus, you can apply the principles to create the 

animated character.  

Outcomes 

 

Upon completion of this unit you will be able to: 

 

Outcomes 

 Understand the stages of 2D animation 

 List the techniques of scanning inked drawings 

 Use GIMP to scan and edit images  

 Work with ink and paint in GIMP program  
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Terminology 

 

 

Terminology 

Background: It is thearea where the action takes place. 

There are usually very few backgrounds in a 

film compared to Cels.  

Cel&Cel setup: A picture is drawn on a unique place of plastic. 

This plastic is called as Cel. At least one Cel 

overlays on a base which is known as Cel 

setup. 

Depth of Field: Depth of field deals with the range of depths 

over which objects in a frame are in focus. It 

forces the eye to focus on the next focal place. 

Depth of field is very important in computer 

animation. 

Maquette: It is a statue based on the model sheet. 

 Model Sheet: It is the drawing of a single character in a 

variety of attitudes and expressions, created 

as a reference guide for animators. 

 Motion Blur: Motion blur helps in bringing the frames 

together & eliminating the jittery images that 

can come from animation.  

 Rough Animation 

Drawings: 

They are the original first sketches of a 

character in action. In computer animation, 

it’s done with wire frames. 

 

 Rough Sketch: It is the animator’s drawings used in the 

process of creating the finished image to be 

transferred to Cel. 

 

 Xerography: It was tested in sleeping beauty and then used 

for the first time as a feature in 101 

Dalmatians.  

 

 Computer 

Assisted 

Animation: 

Animation performed by hand, with the 

computer, creating the in between steps. 
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 Background 

Layout: 

Accurate drawing that depicts everything in a 

scene that has to appear in the background, 

prior to the animation or background art being 

created. 

  

 Ink and Paint 

A long time back, our only alternative for painting animation 

drawings was to trace the image with ink on top of Cels. At that 

point, the colours were painted onto the Cel. The Cels were then 

stacked on racks to consume scarce space. As clear as the Cels 

seem to be, they must be stacked to six or seven levels because of 

a somewhat loss of light and shading with each layer.  

Then the ongoing procedure called "Digital Ink and Paint" came. It 

is the similar process as traditional ink and paint until, after the 

animation drawings are finished. Instead of being transferred to 

Cels, the drawings are scanned on to computer or drawn directly 

on the digital program (for example, a Pen tablet), where they are 

coloured using a software program. With all the ink-and-paint 

programs now advanced features, we can paint a whole area in a 

click or use an advanced paintbrush to colour a character. We can 

change the line colour, improve the drawings, scale and adjust the 

animation layer, build a customized palette and also can export 

the output in various formats. In addition, all programs have the 

dope sheet for tracking record of our animation.  

With computers, exchange of artwork between different 

departments, states and even nations has become easier.  

As the cost of both inking and painting, new Cels for animation 

programs and the reuse of older Cels for new programs goes up, 

the cost for doing the same thing digitally goes down. The digital 

ink and paint process became the standard for animations. The 

computerized ink and paint animation drawings are created and 

organized in computer through bitmap or vector graphics. This is 

advanced digital procedure of traditional methods like morphing, 

onion skinning and rotoscoping.  

There are some differences between the latest ink and paint 

programs. The main difference is in the interfaces of each 
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software, their user-friendliness, project management, camera 

and compositing functions and capabilities to keep the images as 

bitmap pictures or to vector formats. Vector Images have lowerfile 

sizes and can be scaled to any size without quality loss. 

The various procedures inside ink and paint programming are 

broken into different module. In digital painting, camera or 

compositing modules may not be required, so some selected 

modules should be procured to keep the cost down. These 

modules we use on different computers.  

To begin the ink and paint process, various parameters should be 

set for every scene. Each ink and paint program enables you to 

modify different parameters, some with limited options and 

others with a large number of options. 

Digital ink-and-paint programs arethe computerized adoption of 

complete2D animation using: 

 Scan 

 Tracing 

 Ink and Paint 

Choose the Right Software 

Picking the right software is a lot like picking the right car, but it 

depends upon your feel and preferences, you may prefer one 

bellow the rest. The following is a quick list of the best 

professional 2D animation software. You can use it to animate and 

produce your video. Take a look at these to determine the best fit 

for your skill level and budget. 

 Free software: Pencil, Ink & Paint, Tupi, Synfig Studio, 

Plastic animation Paper, Gimp, Krita etc. 

 Professional grade software: Adobe Flash, Toon Boom 

Let’s select the Open Source free software GIMP as it is user 

friendly for beginners.Now we start the techniques of Paint and 

Animate (Scanning, Tracing, Ink and Paint).  
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Technique for Scanning Inked Drawings 

 

 

 

 

 

 

 

 

Title-Image Scanner 
Attribution-User:Dhscommtech 
Source- 
Link-https://commons.wikimedia.org/wiki/File:Image_Scanner.JPG 

After all the hand drawings are finished, then it is scanned through 

the computer scanner. The large scanner with auto feeder is too 

expensive for a small production. These categories of scanners 

together with the right software can read the drawing sheet holes. 

So even if the drawing sheet was not properly aligned, the 

software automatically positions all the drawing sheets at the right 

location. 

Before we scan a drawing sheet, we need the followingtools:  

 Good scanner  

 Scanning software 

Scanning Via GIMP 

Considering your scanner has been set up and it's associated with 

your PC/network, the actual steps you use to scan a picture (or 

anything else) will rely upon your scanner. Ordinarily, it will be one 

of the following:  

Begin "The GIMP" to start the scan 

• Select "File" menu, select "Acquire" and afterward 

"TWAIN". In the event that you don't see these choices, 

you may need to choose "File > Scanner > Import". Here 

"TWAIN" is the scanner. 

https://en.wikipedia.org/wiki/User:Dhscommtech
https://commons.wikimedia.org/wiki/File:Image_Scanner.JPG


 

 

Unit-1 Painting & Animating Practical 
  

16 
 

 
 

 
Screen shot 

• Select the scanner, you are using from the rundown. If you 

don't see your scanner here, it might be that the scanner 

driver is not installed. 

 

 
Screen shot 

 

• GIMP has accessed the scanner software via TWAIN 

standard. The scanner software makes it quite simple from 

here on. You can click "preview" to check that your 

photograph is positioned effectively or not. You can also 

change the scan quality. Note that in case you're just going 

to utilize the picture on the HD Video, 300 dpi is fine. 

Having said this, by increasing the resolution, the more 



   
 2D Animation 

 
17 

 
 

 

detail you capture (and the bigger the image becomes). 

Higher resolution will often result in a much larger file size, 

so check the file size once you've scanned it. 

 
Screen shot 

• After clicking the "Scan Now" button, the scanner starts 

making noises and after a few seconds, the image pops up on my 

screen. Note that this image has been transferred to my graphics 

software (The GIMP).  

 

 

Screen shot 
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So, now that the photo has been scanned, you can save it just as 

you would any other file (i.e. via the "File > Save As..." menu). 

Once you've saved it you don't need to do anything more. Having 

said this, you can make changes to the image as you wish. For 

example, you might want to resize it, use a filter such as 

"sharpen", "despeckle" etc.  

Presently the photograph has been scanned, you can save it 

similarly as you would some other file (i.e. By means of the "File > 

Save As..." menu). Once you've saved it you don't have to do much 

else. Having said this, you can roll out improvements to the 

picture as you wish. For instance, you might need to resize it, 

utilize a channel, for example, "sharpen" and so forth. When it's 

done, stop your scanning application. 

If you are utilizing your photographs on the web, you'll have to 

ensure you save it in the right format. 

Edit Scanned Image 

 

 
Screen shot 

If the scanning application hasn't opened up picture automatically, 

you have to open the scanned image manually. If you zoom in, 

you'll see it looks extremely crude and pixelated. It'll disappear in 

the subsequent steps. However, before we do that, we should 
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remove the white paper background and any mistakes. Rotate 

image if necessary, select the Eraser Tool (press SHIFT + E on your 

keyboard) and remove any lines or those things you don't need. 

You don't have to go into the small details at this time, so just give 

it a quick correction; once over and you may save the image. 

Now, since we scanned in Line Art/Bitmap, we need to switch the 

mode to Grayscale, to do that just select Mode->Grayscale in the 

Image menu. A dialog box will come up, but just leave the setting 

at 1 and click OK. 

Next, open your Layerspalette; press Ctrl+L on your keyboard if it's 

not already visible. You'll see the layer's name has a little padlock 

next to it, so click twice on the layer's name and click OK, without 

disturbing the other settings. 

 

Choose ByColourin the Select menu. Set the Fuzziness to 0, click 

once in the white "paper" part of the image and press OK.  

You'll see that all the white parts of your image have been 

selected. Now hit Backspace or Delete on your keyboard, it'll be 

removed and replaced by a checker grid, indicating that it's now 

transparent. 

It is recommended to create a new white layer behind your 

drawing so you can see it better. 

Scale Image 

 
Screen shot 



 

 

Unit-1 Painting & Animating Practical 
  

20 
 

 
 

 
Screen shot 

In the Image menu, choose Scale image, set the Resolution to half 

of what it is currently and press OK. 

 
Screen shot 

Here's the rundown for the GIMP user.  

 

 Scan your artwork in Line Art at twice your planned 

determination  

 Remove any evident mix-ups  

 In Grayscale Mode, open your layer  

 Use Select-> By Colour to choose the white foundation, at 

that point to evacuate it  

 Go to Image Size and set the resolution to half of what it 

was before 

 Complete 
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Note: If you often scan a lot of drawings in high resolutions it is 

recommended that you save them in the bitmap mode for later 

use and do the following steps when you need to. In the long 

run,it becomesa huge difference in file size. Even though you 

might be able to get the same results by scanning in grayscale, 

adjusting the levels and removing any irregularities, this method 

will save you a lot of time.  

Preparing the Image 

 
Screen shot 

 
 File>Open>Select image to manipulate 

 If necessary, Image>Transform>Rotateby necessary 

degrees 

 Using Rectangle Select Tool, select area of image* to be 

traced 

 Copy area to clipboard (Ctrl + C) 

 File>New>Choose US Letter 

 Paste an image (Ctrl + V) to New Untitled Image 

 Layer>Scale layer 

Path Tracing 

Launch GIMP and open an image that contains an object you'd like 

to trace. 
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Screen shot 

 

Press "Ctrl-B" to view the Toolbox window if it's not visible, and 

click the window's "Paths" tool to select it. The Paths tool looks 

like a blue pen with a yellow tip that sits to the right of a white 

bar. That bar contains three boxes stacked vertically. A white 

curve extends from the top of that bar to the brush's tip. GIMP 

displays the tool's name when you move your mouse cursor over 

the correct icon. 

Click a point along the edge of the object you wish to trace. For 

instance, in the event that you need to trace a building, click a 

point along the building's edge. When you do that, GIMP puts a 

little dot by then. Move your cursor a short distance along the 
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edge and click a new point. GIMP puts a dot at that location and 

draws a short line segment between that dot and the past one. 

 

 
Screen shot 

Keep moving your cursor short distances along the object’s edge 

and clicking points to draw short line segment. Eventually, you will 

draw a path around whole object. When you reachthe starting 

point (the location where you made the first dot), double click the 

dot to finish the path. This path will comprise all the small line 

segments you made by putting dots along the path. 

Using Path 

Click "Windows," select "Dockable Dialogs" and click "Paths" to 

open the Paths dialog window. This window has an icon that 

represents the path you traced. By default, its name is 

"Unnamed." If you had multiple paths, you would see them in this 

window.  
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Screen shot 

Review the buttons at the bottom of the window. Click the "Path 

to Selection" button if you'd like to convert the path into a 

selection. 

Find the window's "Paint along the Path" button. This button 

enables you to generate a line around your object automatically 

using the path you traced.  

Click the “Paint along the Path” button, and type a value in the 

"Line Width" text box. That value determines the line's width in 

pixels. To draw a line around the object, click "Stroke". The line's 

color matches the project's current foreground color.The line's 

shading matches the venture's present foreground shading. 
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Screen shot 

 

After you make a selection from a path or draw a line around an 
object, you can delete the path by choosing it in the Paths 
dialogue window and clicking "Delete." You would then be able to 
upgrade the selection any way you like better.  

When youtrace a path around an object, you can click and drag 
any dot along that path to modify the line segment at that 
location. You'll most likely need to do this since it's hard to trace 
around an object perfectly. For example, in the event that you see 
that one line segment has a space between it and the object's 
edge, you can click and drag the two circles at either end of the 
segment and move them to bring the segment closer to the 
object's edge. Your goal when tracing is to make your outline fit 
flush against an object’s edge. 

If you want to trace a small object, do that more precisely by 

clicking the drop-down box at the bottom of the image window 

and selecting a zoom percentage. Select "400%," for instance, and 

GIMP makes the image four times larger. 
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Tracing the Image 

 

 
Screenshot 

 
 Create New Layer 

Layer fill type Transparency (default). Naming the Layer 

"trace" is helpful. Be sure the new layer "trace" is 

highlighted 

 Select Pencil Tool 

 Choose brush size based on thickness of lines you prefer  

 Begin "tracing" the important lines of the image 

TIPS: Be sure to save your work occasionally.  

Use Zoom Tool for more accuracy 
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Numbering 

 

 
Screen shot 

 
 Once an entire image is traced to preference, Remove 

visibility from pasted layer. 

 This is done by deselecting the "eye." 

NOTE: Only the tracing should remain. This should resemble a line 

drawing. 

 Select the Text Tool. 

Set font & size. Try Smaller, may be necessary depending on the 

detail of the trace. 

 Click on an area of the trace to be numbered. Enter # for 

each area. 

TIP: 1-5 colour regions works best. If using a colour photo, try 

Posterizing it before tracing as follows. 

 Colours>Posterize. Try 3-10 levels. 

Paint 

Scan the pencil Drawing 

First step is the scanner acquisition with Xsane of drawing (HB 

pencil on A4 paper). Scan it with Gray level at 300dpi. To get an 

excellent outcome, first clean the Background white. 
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Real pencil Drawing drawn by Author 

Paint Using GIMP 

This projectuses GIMP to make Paint by Number of a particular 

picture, be it low resolution GIF of some object or high resolution 

photograph. 

Paint and Ink 

Start to change to convert the pencil artwork in a light blue range 

of colours; use the tool colorize ( Color> Colorize ). 

 
Screenshot 

The colorize tool in action 
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With the Pen tool of Gimp-painter, start to ink the drawing, on a 

different layer. The screenshot above demonstrates the setting 

with Pen tool. 

 
Screenshot 

Starting the inking process 
 

Toward the end, include a white layer under the line-art to 

complete the inking. When it's complete, save the work, and  save 

in another file a duplicate of the last Line-art layer;it will be 

required later. 

Multi-Fill 

This is an important section of this instructional exercise. Include 

another layer under the line art, and start with a thinner pen in 

darker to draw the limit of each different color zone I want. I 

flatten the layer when it's finish. 
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Screenshot 

Setting up the zone for the Cell-shading 

Launch the script 'Multi-Fill' with the same setting as in the 

screenshot above and let the scriptdetect each closed zone, and 

fill with arbitrary shading. 

 

 
Screenshot 
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The flatting-tools script in action 

When it's done, delete the layer above with Line-art + red limits; 

and load (Load as new layer ) old copy of final Line-art ( the one 

without red lines). 

 

 
Screenshot 

The result of the flatting tools 

As you see on the animation above; the benefit of this script is in 

the clean result of the colorization: each zone frontier is right in 

the middle of the thickness of your black lines.  
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Summary 

 

Summary 

This unit focuses on three central areas of 2D animation 

production –‘Scanning’, ‘Tracing’ and ‘Ink &Paint’. You have 

learned the selection of proper software for scanning and 

painting. Besides, we also discussed the techniques of scanning 

inked drawings, editing of scanned images, tracing of image paths, 

painting your imagination using through GIMP.  

Assessments 

 

Assignments 

1. How you can resize the image in GIMP? 

2. How do you select an exact colour to match? 

3. Explain How to organize layers? 

4. What is a lasso tool? 

5. Explain the difference between Layer and group 

6. Create a path in GIMP 

7. Create a duplicate layer 

8. Describe how to rename a layer 

9. Explain pen tool’s job 

10. For a perfect straight line in any direction, which tool we 

used? 

11. Explain digital ink and paint 

Resources 

  

Reading 

 Traditional animation book  

 GIMP: 6.2. Paths 

 http://www.quackit.com 

 GIMP: 6.2. Paths 

 Maximum PC: 10 Sweet GIMP Photo Editing Tricks 

 GIMP: Main Windows - The Toolbox 

 http://gimp-registry.fargonauten.de 

 http://www.questionablecontent.net 

 http://creativecommons.org 

http://www.quackit.com/web_graphics/gimp/tutorial/about_gimp.cfm
http://gimp-registry.fargonauten.de/node/14051
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Unit 2 

Understanding Background 
Composition  

Introduction 

In this unit you will know the practicalities of 2D animation 

background composition; explore the rationale behind various 

functions of layout and background composition principles with 

clear visual examples. This unit is designed chapter-by-chapter, to 

sequentially build fundamental on components of background 

composition with easy to follow step-by-step examples and 

diagrams. Beginners in the field will hopefully find the information 

contained here, a good starting point. 

Outcomes 

Upon completion of this unit you will be able to: 

 

Outcomes 

 

 Understand the basics of background composition in 

animation  

 Plan the background  

 Create a margin in GIMP 

 Know how to create backgrounds in Pencil 2D 

 Create and design a background with multiple layers 

 

Terminology 

 

Terminology 

Animation Layout 

: 

Exact drawing which designs the volume and 

situation of activity in a scene. There are 

normally two different kinds of layout in 2D 

animation such as BG Layout and the 

Animation Layout. 

Atmospheric Experimental color sketches describing the 
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Sketches: moods and setting for a secnce  

Background 

Layout : 

Accurate drawing describing everything in a 

scene that is to appear in the background, 

prior to the animation or background art 

being created.  

 Rough Outline : It is the artist's drawings used as a part of the 

way towards making the complete picture 

which is to be exchanged to cel. 

 Clean up: The act of standardizing the appearance of a 

drawing or image.  

 Exposure sheet: A printed diagram format which shows each 

frame, exact layers, actions and dialogue 

columns for different timing and breakdown. 

Also it is known as a Dope Sheet.  

 Flipbook: A simple process of movement made by 

drawing small figures at the edge of a book 

and watching them move as the pages are 

flipped.  

 Foreground: Finished artwork depicting all that does not 

move in an animation scene. Usually seen in 

front of the animated action in the form of an 

overlay level. Opposite of Backgrounds.  

 Hand Tracking : The process where the animation is traced, by 

brush or pen, onto the Cel by an Inker. 

 Image Map: A term used in game animation to indicate 

the background image. 

 Master 

Background: 

The animated equivalent of a live-action 

master shot. Establishes the setting, lighting 

and scale of a sequence but may not be an 

actual production background.  
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Drawing Concept 

Understanding Background Composition 

Now, we are going to learn the basic background composition 

rules, software and techniques used for animation. 

Hardware 

One of the primary things needed to create a background is a Pen 

tablet. With Pen tablet we can draw straight into the computer 

using a pen. Use of Pen Tablet makes animation easier as we don't 

need to draw it in the traditional way. In the traditional way, we 

have to draw into a paper and then scan it into the computer or 

take pictures. But that's quite a long process and we can't preview 

what we've drawn, whereas in the software and computer we can 

draw something and straight away look through the footage and 

check if it works or not. So a Pen Tablet is very beneficial in 

creating a background.  

Software 

The next thing required is software such as: Flash, Blender, 

Illustrator, Adobe Photoshop, Gimp, Toon Boom etc. Let’s use 

“pencil” and “Gimp”, which are open source and have all the 

features of normal animation software. In ‘pencil’ you will able to 

make films for free. If you find yourself liking 2D animation you 

can go ahead and buy some better software. But to start with, 

some free software is perfectly fine. 

Creating the Margin 

 
Screenshot 
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First start the GIMP or any supported software, open a new 

project and select the image ratio of the canvas 

 

 
Screenshot 

 

Then select the frame size as per requirement, and then click OK. 

 
Screenshot 
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Start the creation of first margin, which is known as the outer 

margin. Now we got the new transparent layer and rename this 

layer as margin. 

 

 
Screenshot 

 

Then select the square selection and create the outer margin, and 

convert the square selection to path. After the path is selected, 

deselect the path and select the paint tool and choose the margin 

size. After resizing, go to create the margin through path tool, 

then repeat the above process for the inner margin. 

 

 

 
Screenshot 
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Screenshot 

Save the file and export the margin as the bitmap format. Now it is 

completed in Gimp, but it is not supported in pencil 2D. 

 
Screen shot 

 

So now open MSPaint program and open the margin sheet or 

import in paint.  

 
Screen shot 
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After importing, save the file in bitmap format again.  

 
Screen shot 

In this process pencil 2D supports this bitmap margin. 

How to plan a background? 

Now we know about the background, it tips where to position the 

characters in the background and how to move the camera and 

edit different points and how to manage other details. 

Screenshot 

 

 
Screen shot 
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On the above figure, we have a simple sequence, a character that 

is coming towards camera from a background. Here it's an opening 

shot. Let's start setting the scene. First, we create a new vector 

layer and then draw on the drawing area. Select the fat brush tool 

and plan the backgrounds eye leading area. 

 

 
Screen shot 

 

Let’s use the brush tool to mark. It's a lead-in shot, zoom in the 

frame. After we get the character’s position area, now the mouse 

is kept on the character and that is where we're going to have our 

hero.This was planned in pre-production process. Now slide up to 

the background where character is not animated and it is going 

out of the dark.  

 

 
Screen shot 
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Now, we may think about our lighting condition and put the 

framer on the background. It is then planned according to what's 

going to happen in the scene. The character is coming forward in 

the scene, therefore here we need to think about all that 

background space characters that are going to be in dark as the 

character reveals on close observation. Now we have to plan the 

shots exactly like that, which must be adding the mood. 

 
Screenshot 

Note: Inorder to give a sense of revealing to the character into the 

scene where character blends with the environment, dynamic 

camera techniques like first camera angle is set according to 

character's point of view. Now the camera zooms out and the 

character walks into the scene. 

 

 
Screenshot 

 

When we have a look at the background we can see that 
it's a long drawing. 
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Screenshot 

Now focus of the camera moves on the background as we 

predetermined. The green line is the beginning point and red line 

is the end point. You can see that we have created a background 

which is looking as if it is at a distance far away from the scene. 

But you don't really notice the bridge or anything else in the 

background because if we look at the background, although the 

whole background can be seen.But the focus is on the door, so 

when we see him walk in, we can see the scene in character’s 

point of view. 

 

 
Screenshot 
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So here is a small directional style of shot where the shots have 

been divided. It is displaying different angles of shot like profile, 

close-up, mid close etc. 

 

 

 

 
Screenshot 

 

Here in the scene, as we can see the character and the statue is 

taken in close shot. Then the character turns his head to change 

the direction of view point of the shot. By such techniques, 

directors give the audience a feel of suspense inorder to 

understand the scenario before introducing the statue, through 
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his actions, look and the geography of the background. When we 

turn off the geography and review the background  

 
Screenshot 

We could sense its absence in the background. The statue is facing 

towards the audience and the character is placed towards the left 

in the scene. Having the character in the shot, a little bit of editing 

is usedto keep the background left of the character and the 

character to our left. If our face is towards the character from the 

background point of view his left would be to our right. 

 
Screenshot 
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Screenshot 

In the above figure by creating a small movement of the statue, it 

portrays as if it is threatening or frightening kind of disturbed 

feeling to the background atmosphere. 

How to create and design a background with multiple layers 

 

 
Screenshot 

Now open the pencil program to start the background design. This 

is the pencil’s margin template. First of all, copy (Ctrl+C) the 

margin and paste (Ctrl+V). Now, add some key frames on 

animation layers. Goto layers and add another layer and rename it 

as Background Layer because now we are creating the 

background. 

 
Screenshot 
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Now we have got the drawing area, we are nowready to draw and 

can paint the background. Let’s start a simple background having 

grass. In the beginning, the work area is zoomed for ease to work. 

Then go to the tools, select the sketch tool and draw a simple 

ground grass field layer. 

 
Screenshot 

Then select the BG colour layer and select the coloring tool. Go to 

the alpha layer and check all the settings of brush and colour tools. 

Select the required colour for background and start colouring. If 

our colour exceeds a little bit from the margins inner outline, it’s 

ok but don’t cross the outer margin. Note: When we paint, we 

don’t erase the margin outline. If we are erasing it, we will lose the 

frame alignment. 

 
Screenshot 

When we colour the background, we can use all the tools as per 

coloring requirement like coloring tool, zoom, sketch, fill and pick 

colour. Then erase the margins over colours and clean it through 

the erase tool.  
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Screenshot 

Now, we can do some detailing on the background through the 

smuggled, erase and colouring tool. In colouring period, select the 

proper brush size from the tools layer for detailing the 

background. 

 
Screenshot 

 

Now we add some light colours on the ground for detailing the 
grass background layer. 

 
Screenshot 
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Then add some sky blue colours of the sky.  

 
Screenshot 

Select the white colour from colour layer and add some cloud on 

the sky layer through the colouring tool. Use the alpha tool, 

smoothly erase some sky colour, and draw the layer which would 

look like the cloud on the sky. 

 

 
Screenshot 

Now it is the final background output and you can save and export 

it.  
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Unit Summary 

Assessment 
 

 

Assessment 

1. Explain the process of creating margin 

2. Describe creation of background 

3. Elaborate the process to design a background with multiple 

layers 

4. Explain what is layout design 

1. List the types of colour use in inking and colouring 
 

Resources 

Books for Reference 

 The Animator's Survival Kit: Richard Williams 

 Timing for Animation: Harold Whitaker and John Halas 

 The Animator’s Guide to 2d Computer Animation: Hedley 

Griffin 

 Character Animation-2d Skills for Better 3d: Steve Roberts 

 How to Make Animated Films: Tony White 

 Flash Cartoon Animation: Learn From the Pros 

 The Art of Flash Animation: Creative Cartooning: Mark 

Stephen Smith 

Web resources: 

 http://pencil-animation.org 

 http://www.awn.com 

 

Summary 

In this unit, you have learned about 2D animation background 
composition tricks. We discussed about understanding and skills 
about different type of background composition by exploring 
relevant techniques and processes as well as creating a practical 
background composition. We also learned about the Pencil 2D and 
Gimp animation software and the production process to create an 
animation background.  

 

Reading 

http://www.awn.com/
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Unit 3 

2D Animation Techniques   

Introduction 

2D animation figures are made and/or edited on the computer 

using 2D bitmap graphics or created and edited using 2D vector 

graphics. This includes automated computerized versions of 

traditional animation techniques such as interpolated morphing, 

onion skinning and interpolated rotoscoping.  

2D animation has several applications, including computer 

animation, Flash animation and PowerPoint animation.  

In this practical unit, you are going to learn how to create 2D 

animations. It will teach you how to get started, what equipment 

you're going to need and software required.  

This unit will make you understand the pencil 2D animation tools 

and how to apply them to create a basic 2D animation.  

Outcomes 

Upon completion of this unit you will be able to: 

 

Outcomes 

 Apply the 2D Animation Techniques 

 List various Techniques of 2D Animation  

 Name the software’s used for 2D Animation  

 Apply pencil animation tool 

 

Terminology 

 

Terminology 

Bitmap image: 
Computer graphic consisting of “pixels” on a grid. 

Each “pixel” contains color information for the 

image. 

Vector image: 
An alternate option for bitmap image is vector 

image. It depends on mathematical equations 

defining the lines, shapes and points that 

structure the image.  
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Key: 
A placeholder on the Pencil timeline contains 

information about what the layer should show or 

produce at the frame where it is located. A key 

characterizes vital purposes of movement in 

animation.  

 Onion skin views: 
A view alternative inorder to show the past as 

well as subsequent key frame as semi-

transparent.   

 Model Sheet: It is the drawing of a single character, in different 

poses created as reference for animators. 

 Character Models: First a model sheet of any character is made by 

the animator. The model sheet contains the 

character in a variety of facial expression & poses, 

which will serve as the model for each time they 

are drawn. 

 X-Sheet: 
It is also called an Introduction Sheet or a Dope 

Sheet. It is a worksheet that gives particular 

guidelines on how the animation should be 

captured. It is used to planning the timing and 

activity and incorporates details on field, camera 

and action.  

 Rough Sketch:  
It is the animator’s drawings used in the process 

of creating the finished image to be transferred to 

Cel. 

 Layout: 
The black & white rendering done by a layout 

person that determines the basic composition of 

the scene. 

 Traditional 

animation: 

The black & white rendering done by a layout 

person that determines the basic composition of 

the scene. 

 Computer 

Animation  

The animation is created digitally using computer 

techniques.  

Hardware 

One of the primary things is to create a 2D animation is a Pen 

tablet. With Pen tablet we can draw straight into the computer 
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using a pen. Use of Pen Tablet makes animation easier as we don't 

need to draw it in the traditional way of animation. In the 

traditional way, drawing was initially drawn in paper and then it 

was scanned into the computer or pictures are taken. But that 

took quite a long time and was a lengthy process. Also it didn’t 

have provision to check the preview of what has been drawn. 

Whereas in the software used in computer, we can draw 

something and straight away look through it to check if that the 

footage works or not. So a pen tablet is very beneficial in creating 

a background.  

Software 

The next thing required is software such as: Flash, Blender, 

Illustrator, Adobe Photoshop, Gimp, Toon Boom etc. Let’s use 

“pencil” and “Gimp”, which are open source and all the features of 

normal animation software. In ‘pencil’ you will be able to make 

films for free. If you like 2D animation you can start with free 

software and latter work on higher professional software. 

Pencil 2D animation  

Pencil is free and open-source 2D animation software available for 

various operating systems. One can use it free by just downloading 

it from internet.  

Let us discuss some basics of pencil through some figures: 

 
Screenshot 
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You can see above figure on red circle area, it shows the tools of 

pencil.    

1.  Sketch 

2. Colouring 

3. Draw 

4. Polyline 

5. Erase 

6. Clear 

7. Fill 

8. Pick Colour 

9. Marque Selection 

10. Move Object 

11. Zoom 

12. Modify Curve 

Colour 

 
Screenshot 

In the above figure, you can see there are basic colours, main 

colours and different variations like Blue, Gray dark and skin 

colours. These will go a long way as far as animation colours are 

concerned. Let’s say you have an image or something you want to 

get that colour. Pick whichever colour you want and put it in 

colour pallet, so that you can use it on your pencil and save it 

anywhere.  

When you save colors, it chooses any one of your color and keeps 

the label on it. Here you can add customized colors by using the 

drop in the ‘pick colour tool’ which is called a Dropper. After you 
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select pick colour tool, you can see the selection tool through it 

where selection can be done from up or down. While using the 

"move tool" sometimes it stops at few selections where the colors 

are not visible. It is one type of color adjuster. 

Layers 

 

 
Screenshot 

 

When working in pencil, it's possible to create several different 

layer types. If you look at the timeline, you notice that the layers 

have different symbols and colored bars at the side to indicate 

layered type. For example, vector layers have a violet bar and 

colorful symbol on the left hand side. You can change the color of 

these layers by going to the program menu bar and select Edit > 

Preferences then from the Preferences panel, choose the Colored 

tab and select the colour you want to change. Also add or remove 

layers on timeline – Layers, click + / - (+add / - remove).There are 4 

types of Layers in the Time Line: 

1. Bitmap Layer 

2. Vector Layer 

3. Sound Layer 

4. Camera layer 

 

Bitmap Layer 

 
Screenshot 
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Bitmap Layer is used for raster graphics. On the Bitmap Layer, we 

can work with different type of format like BMP, DIB, GIF, JPEG 

etc. It is important to note that, if bitmap image is condensed, the 

image look like blur and pixels.  

 

Vector Layer 

Vector layer is always used for vector graphics, because when we 

want to increase or decrease the vector files size it work without 

any quality changes.  

 

Sound Layer: 

 

 
Screenshot 

 

Adding Sound layer, first go to menu bar>Edit> Import sound file 

from your stock of sound files. When sound is added, a black 

triangle will appear on sound layer indicating where the sound will 

play during start. You can move this triangle as any other keys on 

the time line.  
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Camera Layer 

Screenshot 

 

Camera layer puts limits on the height and width of video. Double 

click on the camera layer then choose the size. You could do 540 x 

400 or whatever size you want. Set the height and width of your 

camera and go to file, then export the movie of that dimensions. 

Camera scan move the whole movie in one key frame if that 

makes any sense. For instance, if a new key frame is added in 

camera layer, youcan use the drag tool to drag it a little bit and 

add another key frame. Drag it a little bit more, then add another 

key frame and again drag it a little bit more and then you will have 

a moving thing. 

Add and delete Layers 

 

 
Screenshot 

If you need extra layers in timeline we can add or delete from the 

timeline. For adding a new layer, click + (plus) button next to 
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“Keys”, it will show four types of new layers from them select any 

one new layer which you require, then add it in your time line.  

If you want to remove/delete any existing layer, select the 

particular layer from the timeline and click – (minus) buttons next 

to “Keys”. Then a warning dialogue box shows on screen. If you 

are sure to delete the selected layer, press OK. Then the layer is 

removed from the timeline. 

Rename Layer 

 

 
Screenshot 

 

If you want to rename the layer, doubleclick on the name of the 

layer in the timeline. A window will pop up, allowing you to edit 

the layer’s name. Click OK when you have changed it to the name 

you want and the new name will appear in the timeline. 

Resize Image 

 
Screenshot 
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Through the Select Tool we can resize or move the image. Using 

the select tool, draw a rectangle in the region of the image. Use 

the arrow tool or move object tool for moving or resizing the 

image. To move an image select the image and click the mouse 

button on the image and drag, as per requirement. If you want to 

resize the photo, click on the select area corner point, press the 

mouse middle button and drag the select area. 

Import in Pencil 

 

 
Screenshot 

 
You can import a raster image at a particular frame in a bitmap 

layer by using the Import image command in the File Menu under 

Import. Alternatively, you can drag and drop bitmap images from 

an external window onto the canvas. A key is created for each 

imported image. This is particularly useful when you have a lot of 

images. By default, the center of each image is set to the center of 

the view. If you want to import your images at a particular 

location, use the select tool and drag a rectangle on the canvas. 

The images will be imported in the rectangle. If the images are 

larger than the rectangle, they will be rescaled. 
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Animating 

 

 
Screenshot 

 
Key Frame is displayed as a rectangle at the time line. Grey colour 

specifies that the key frame is empty. Coloured frame indicate that 

here is an image in frame. Black colour indicates that frame is 

selected – you can move selected frame: click on a frame and drag 

it to the needed place. To shift more than one frame, hold down 

the Shift key. 

 

 
Screenshot 

 
Onion Skin 

The traditional way of planning images for each key frame is to use 

the previous (or next) key image to guide the drawing of the 

current key image (essentially flipping through images when done 

by the paper method) by displaying the previous (or next) key 
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images in a semi-transparent state. This is called Onion Skinning. 

You can use the Onion skin buttons to activate or deactivate the 

previous and next onion skins. 

 
Export 
 

 
Screenshot 

 

After the animation is made, the final output or film needs to be 
exported. For this go to the File Menu then select the export. As 
per the requirement, you can choose the formats such as X-Sheet, 
Image Sequence, QuickTime movie and Flash movie (swf). While 
exporting the final file, please remember to check the file size and 
the ratio. Adequate camera Layer must be created for exporting 
the final file 
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Unit Summary 

 

 

Summary 

In this unit, you have learned about the process and technique of 

2Danimation. We also discussed about various tools and features 

of Pencil 2D animation software.  

Assessment 

 

Assessment 

1. Write down the tools appeared in tools bar of Pencil 2D 

2. In Pencil 2D, there are four types of Layers in the Time Line  

3. Vector layer is always used for vector graphics 

4. Explain the basic techniques used in 2D animations 

5. Explain Animation process 

6. List the selection tools of animation 

7. What is free transform tool 

8. Explain what time line is 

9. List the different types of image format 

Resources 

 http://pencil-animation.org 

 http://google.com 

 https://wikipedia.co 

 

  

 

Reading 

http://pencil-animation.org/
http://google.com/
https://wikipedia.co/
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Unit 4 

2D Animation for portfolio  

Introduction 

A portfolio is a short video or film footage showcasing 

professionals or presenters previous work. For jobs in the fields 

like film, television, animation and games development. You will 

probably be asked to submit a portfolio as part of your 

application. Irrespective of whatever qualifications and academic 

degrees you have, the portfolio which is also known as Demo Reel, 

is an important factor in deciding whether a multimedia 

professional will get hired or not. It is a direct showcase for their 

work. Portfolios are of usually 2 to 3 minutes in length and 

showcase the artist's skill, talent, experience and past work.  

In this practical unit, we will discuss about animation portfolio, 
hardware and software required for making a portfolio. We will 
also discuss techniques of 2D animation portfolio, various 
techniques involved in 2D animation and how to apply 2D 
animation tools to create a basic 2D animation portfolio for you. 

 

Outcomes 

Upon completion of this unit you will be able to: 

 

  

 

Outcomes 

 Understand Portfolio 

 Know the steps and rules to make a portfolio 

 Create an animated short movie 

 Describe the rules for making Portfolio 

 



   
 2D Animation 

 
63 

 
 

 

Terminology 

 

 

Terminology 

2D animation: The formation of moving images in a two-

dimensional condition. Images can be 

manual “cel” animations or computer-aided 

drawings created with animation programs.  

Bitmap Image: Computer graphic consisting of “pixels” on a 

grid. Each “pixel” contains colour information 

for the image.  

Vector Image: An alternative to the bitmap image, vector 

images depend on mathematical equations 

defining the lines, forms and points that built 

an image.  

Xsheet: Also known as exposure sheet or a dope 

sheet. It is a worksheet that gives particular 

instructions for how the animation should be 

captured. It is used to plan the timing and 

action and includes the details on the field, 

camera and action. 

 

2D Animation Portfolio Making 

Portfolio Making Rules  

For animation and visual effects artists, it's the portfolio that helps 

in grabbing everyone's attention. It’s a vital marketing tool for the 

professional. One must prepare the portfolio or demo reel with 

utmost care, highlighting his/her skill, expertise and creative 

ability. Please remember your show‐reel is the showcase of your 

work. Here are six important principles to keep in mind, while 

preparing your portfolio.  

1. Length 

Nobody has time to watch a 30-minute portfolio. It is 

recommended that the portfolio should be within 2 minute. 

Preferably, it can be shorter. In most cases, people get a good idea 

of what to expect within 30 seconds. Don’t save the best until 
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last.You need to grab people’s attention instantly and keep it to 

watch it all. 

2. Content 

Only best works should be added to the portfolio. A 30-60 seconds 

portfolio with wonderful animation is better than a 3-

minuteportfolio with poor animations. If you are not satisfied with 

something, do not put it. Always use the original shots you have 

done, never recreate the same. If you don’t have a good reason to, 

don’t repeat content. 

3. Order 

Since the portfolio should showcase the best of you, strongest and 

engaging work should appear first. It takes people a few seconds 

to decide if they want to keep watching your reel. There is no 

need of waiting and building the suspense. 

4. Audio/ Fx 

It is a very important part of Portfolio as many emotion and 

engagement comes through the music and editing choices made. 

Include the original audio for dialogue pieces. A simple music is 

the best BGM. The music should not be distracting and should act 

as a connector between the shots. 

5. Presentation 

Every piece should be given the time it deserves.You should not 

edit the music or get too creative. In an animation reel you want 

to present each shot separately (sometimes with a title card 

before each shot) to let the viewer understand what they 

are watching without confusing them.  

6. Numbering  

Write the proper information for each shot in the portfolio. 
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Incomplete works should not be added in the portfolio. Include a 

head and tail slate with your name, phone number and email 

address on the reel. It should be like a complete package of your 

work and personal information. Never include examples of work 

that is not relevant to for the client or animation. 

A portfolio needs to tell a story. Showcase your personal strength 

and passion through the portfolio. Be clear on your style and what 

you do best. Also be honest about your work. When a piece of 

work doesn't match your experience or expertise, it might create 

doubts on your abilities.  

The person who reviews the portfolios has to view number of 

reels, one after another, so it is important to build an impact at 

the first impression. Think about the work with which you are 

confident, then include the same in the portfolio. Review again 

and again before finalising. 

How to make Animated Short Film 

Making animated movie from scratch involves many stages. The 

process of production for a typical animated short film can be 

divided into three stages: Pre-production, Production and Post-

Production.  

In this section, we will discuss about step by step methods of 

animation short film making. Now we need the animation 

software to start. Lets select GIMP for imaging, Openshot for 

editing the video and pencil 2D for animation. 
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2D Animation Pipeline (Created by Author) 

Step 1: Select script  

One of the most important stages of any film production is Script. 

One can choose the best story or can write the story; for example 

an animation of simple bird as given here. Then it is important to 

make an outline of what you want to show. In animated films, 

visual scripting of the action and performance is important.  

If you write a script, it’s better to make a perfect plan. But, if the 

story is not complete, then start the rough drawing and in the 

production process give the best direction tothe film. 

Step 2: Create the Character 

First develop the characters sketch in a perspective view. This rule 

implies that the characters aren’t directly facing the viewer; 

they’re angled 3/4ths to the left or right, like the example below. 

This view suggests that our characters aren't clearly standing up to 

the viewers; they're figured 3/4ths to the other side or perfect. 
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Screenshot 

Step 3: Creating Storyboard 

 

Title-Storyboard 

Attribution-Angela rees 

Source- 

Link-https://mooc.employid.eu/storyboarding-tutorial/ 
 

The Storyboard is a manual hardcopy version of the animation film 

and plan for the actions and dialogues for animation. It contains 

https://mooc.employid.eu/storyboarding-tutorial/
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the shot locations, camera angle, sounds and all details of 

cinematic requirements. A storyboard does not need to be super 

realistic with good drawings. But all the key poses should be 

drawn. It will make the work easier. 

After completing and properly naming all the sheets, it should be 

scanned to have them in digital formats. After the scanning you 

can move them for editing.  

Step 4: Creating Animatics 

 

Screenshot 

Simply put, animatic is an animated storyboard or rough cuts of 

animation. Making animatics is fun. In this process, all scanned 

image files are imported into the editing program. At this stage, 

we match the sound and scanned frames as per requirements and 

decide the length of animation. It acts as a reference for 

animators; here, we can see how our movie will look like and the 

story is built-up.  
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Step 5: Creating Background Layout 

 

Screenshot 

A background layout is the pencil hand drawing for a scene. It is 

not the final background, just for reference of the scene. Here we 

start drawing in the right place and size as per our BG field guide. 

Since we know what our backgrounds look like as of now, we will 

draw as it is required to be in the shot. For instance, we don't have 

to draw a whole mountain when we might be utilizing section of 

trees.  

If we are re-utilizing the BG later in a different field size, we need 

to draw a large size background so that we can use it for both 

without losing any pixels. 
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Step 6: Creating Exposure Sheets 

 

Screenshot 

Exposure sheet is a very important thing in animation. A simple 

exposure sheet contains a table with some lines and column 

segments like Action, Dial, Cel Levels, Background, Camera, Scene, 

Sequence and Sheet Number. Each line signifies one frame of 

animation. A normal exposure sheet holds upto 4 seconds of 

activity (i.e. 4 seconds x 24 frames = 96 rows). A well-prepared 

exposure sheet will help in maintaining the perfect timing.  

Step 7: Creating Rough Animation 

The initial step in traditional animation is the rough animation, 
which is its skeleton. We should always start the animation from 
the main action. For instance, to animate a walk cycle, we should 
begin with the body movement and the legs. Head, hand and 
clothes can be added later during the secondary animation. All the 
key poses on the storyboard should be made. 

For a perfect animation, always complete the main action before 
adding every other detail. If we start animating all the details right 
away, we may lose a lot of time. If you have to make corrections, it 
will be difficult. 
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Screenshot 

Step 8: Clean-up 
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Screenshot 

Once we finish the animation and are satisfied with the work, we 
can start the cleaning up of the images/drawings. We have to 
choose what kind of line we would use.  

There are various types of line art we can select. Normal lines are 
all of the same thickness while rough lines are not closed and 
make your animations look like they are dancing. Cartoony lines 
are thick around the border with thin lines on the inside. Cleaning 
up the rough animation is a repetitive work, but when we do it 

properly it will make the inbetweening and colouring easier. 

Step 9: Making In-between 

For smooth animation, in-betweens are important. Keys lead the 

animation but the in-betweens smooth out the movements. This 

process is called inbetweening. A huge amount of in-betweens are 

not always required. When we animate an action shot, we can 

make with a few keys and two or three in-betweens. For fine 

animation, more in-betweens give us a smoother result. 

So now let's check the example below. 
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Screenshot 

First we have put frame number 10 and frame 25 on a light box. 
Then label it with frame 25 to add in betweens this. Always it 
should be started from frame breakdown. Here 25 number frames 
are at the centre in between 10 number frames and 40 number 
frames.Now start drawing right in between the two lines of those 
drawings and that is how we create the breakdown. When it's 
complete, we can go to frame number 25 and 40 and create the 
in-between number 28. After we are done with that one, we take 
frame number 28 and 40 to create the last one in the scene 
number 32.  

Step 10: Backgroundsync and Paint 

 

Screenshot 

Background painting should be included behind our characters 

using inking. We can ink it the traditional way with the crayons or 

paint or we can scan the drawing and paint it through the paint 
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program like GIMP. Our backgrounds are a mix of crayons, water 

paints and GIMP. 

It's important to mark all layers and keep them isolated because 

the animation will be placed in the middle of the layers to create 

depth. 

Step 11: Characters Ink and Paint 
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Screenshot 

When all our animation has been cleaned up, it is ready for 

colouring. When we begin this ink and paint, all our movement 

has been tidied up and prepared for paint. 

We can use specialised software to ink all the characters.  

Here, the hard work of clean-up that we did before truly pays off. 

With great line work and closed lines, colouring will be an easy 

walk. 

Step 12: Compositing 

When all the artworks and characters are painted, we can use any 

compositing software to composite it. Composting is the process 

of combining all the elements into a scene. 

Now we set up the entire film together and make it flow into one. 
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Ideas for exercises 

Here are some suggestions for animation exercises.  

 Two leg character walk and run cycle 

 Tiger walk and run cycle 

 Man juggle 

 Throwing balls  

 Man hits a door with a briefcase 

 Baby chews food  

 Sword tussle 

 Kung Fu styles 

 Man cycling 

 man with diving board 

 character’s happy and sad expression  

 Loudly smiling a man 

 dialogue 

 Underwater swimming 

 Walk and run transitions 

 Birds feathering 
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Unit summary 

 

Summary 

In this unit, you learned what portfolio is and how to prepare a 2D 

animation portfolio. We also discussed about the various steps in 

making animated short films. You need to prepare a good and 

impressive portfolio of you skill and work to draw the attention of 

your prospective employers or clients to start you professional 

career in multimedia. 

Assignment 

 

Assignment 

1. What thing should you keep in mind while creating a 

portfolio 

2. Explain the clean-up model sheet 

3. How to create a portfolio 

4. List the various steps in creating a 2D animationsportfolio 

5. What are animatics 

6. Explain uses of portfolio 

7. What is an exposure sheet 

8. What is the requirement of portfolio 

9. List the different types of rows and columns as in the 

exposure sheet 

10. Evaluate the 2D animation portfolio 

 

Resources 

 

Reading  

 https://google.com 

 http://wikipedia.com 

 

 

 

 




